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chapter 1
TROUBLESHOOTING

This guide provides information on how to identify and correct
minor disk, graphics, memory, and software problems. It also
explains many of the messages that may be displayed on the
screen, including specific error messages that may appear during
the Power-On Self-Test (POST) at startup.

POST Message Disabled suppresses most system messages
during POST, such as memory count and non-error text
messages. In this mode, the Compaqg Logo and Web address
appear on the computer monitor. If a POST error occurs, the
screen will display the error message. To manually switch to the
POST Messages Enabled mode during POST, press any key
(except F10 or F12). The default mode is POST Message
Disabled.

The speed at which the computer |oads the operating system and
the extent to which it is tested are determined by the POST
mode selection.

Quick Boot isafast startup process that does not run all of the
system level tests, such as the memory test. Full Boot runs all of
the ROM-based system tests and takes longer to complete.

Full Boot may aso be enabled to run every 1 to 30 dayson a
regularly scheduled basis. To establish the schedule, reconfigure
your computer to the Full Boot Every xx Days mode, using
Computer Setup.

[J For more information on Computer Setup, refer to the
Making Hardware Changes guide.

Troubleshooting



Helpful Hints

If you encounter some minor problem with your computer,
monitor, or software, refer to the following list of general
suggestions before taking further action:

Check that the computer and monitor are plugged into a
working electrical outlet.

Check to see that the computer isturned on and the green
power light is on.

Check to see that the monitor is turned on and the green
monitor light ison.

Turn up the brightness and contrast controls of the monitor
if the monitor isdim.

Press and hold any key. If the system beeps, then your
keyboard should be operating correctly.

Check all cable connections for loose connections or
incorrect connections.

Reconfigure your computer after installing a non—Plug and
Play expansion card or other option. See “ Solving Hardware
Installation Problems” for instructions.

Be sure that al the needed device drivers have been
installed. For example, if you are using a printer, you need a
printer driver.

Take out al diskettes from the diskette drives when you turn
on your system.
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Solving General

Y ou may be able to easily resolve the minor problems described

Problems in this section. If a problem persists and you are unable to resolve
it yourself, contact your Compaq authorized dealer or reseller.
Problem Cause Solution

Computer won't turn on

Computer is not connected to
an external power source.

Connect to an external power source.

Cables to the external power
source are unplugged.

Ensure that cables connecting the computer to
the external power source are plugged in
properly and the wall outlet is active.

A defective PCI or ISA card
has been installed.

Remove any expansion card that was just
installed.

Drive power, data, or power
supply cables may not be
properly connected.

Reseat drive power, data, and power supply
cables.

Computer appears
locked up and won't turn
off when the power
button is pressed

Software control of the power
switch is not functional.

Press and hold the power button until the
computer turns off.

Computer date and time
display is incorrect

RTC (real-time clock) battery
may need to be replaced.
Battery life is approximately
5 years.

First, reset the date and time under Control
Panel. If the problem persists, replace the RTC
battery. Refer to the Making Hardware Changes
guide for instructions on installing a new battery,
or contact your Compagq authorized dealer or
reseller for RTC battery replacement.

Computer powered off
automatically

(Red power LED blinks
four times per second.)

The unit temperature was
exceeded. The fan may be
blocked.

1. Unitis in an exceedingly hot environment.
Let it cool down.

2. Ensure computer air vents are not blocked
and internal fan is running.

3. Contact your Compagq authorized reseller or
service provider.

The unit temperature was
exceeded because the computer
was functioning with the cover or
access panel removed.

Replace cover or access panel, and let the
computer cool down before attempting to turn on
power to the computer.

Computer appears to
pause periodically

Network driver is loaded and
no network connection is
established.

Establish a network connection, or use
Computer Setup or Windows Device Manager to
disable the network controller.

Continued
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Solving General Problems continued

Problem

Cause

Solution

Cannot remove computer
cover or access panel

Smart Cover Lock, featured on
some computers, is locked.

Unlock the Smart Cover Lock using Computer
Setup (F10 Setup).

The Smart Cover FailSafe Key, a device for
manually disabling the Smart Cover Lock, is
available from Compagq. You'll need the FailSafe
Key in case of forgotten password, power loss,
or computer malfunction.

Cursor will not move
using the arrow keys on
the keypad

The Num Lock key may be on.

Press the Num Lock key. The Num Lock light
should not be on if you want to use the arrow
keys.
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Solving Disk Common causes and solutions for disk problems are listed in the
Problems following table:
[ You may need to reconfigure the computer when you add or
remove hardware, such as an additional diskette drive. See
“Solving Hardware Installation Problems’ for instructions.
Problem Cause Solution

Diskette drive light
stays on

Diskette is damaged.

In Windows 95 or 98, run ScanDisk. Click Start >
Programs - Accessories - System Tools »>
ScanDisk.

In Windows NT, right click Start, click Explore, and
select a drive. Select File > Properties > Tools.
Under Error-checking, click Check Now.

Diskette is incorrectly
inserted.

Remove diskette and reinsert.

Drive button is not pushed in.

Push in drive button.

Software program is
damaged.

Check the program diskettes.

Drive cable is not properly
connected.

Reconnect drive cable.

Diskette drive cannot
write to a diskette

Diskette is not formatted.

Format the diskette.

Diskette is write-protected.

Use another diskette or remove the write
protection.

Writing to the wrong drive.

Check the drive letter in your path statement.

Not enough space is left on
the diskette.

Use another diskette.

Diskette write control is
enabled.

Use Computer Setup to check your storage
security feature disabled settings.

Continued
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Solving Disk Problems continued

Problem

Cause

Solution

Cannot format
diskette

Invalid media reported.

When formatting a disk in DOS, you may need to
specify diskette capacity. For example, to format
a 1.44-MB diskette, type the following command

at the DOS prompt:

FORMAT A: /F:1440

A problem has
occurred with a disk
transaction

The directory structure is
bad, or there is a problem
with a file.

In Windows 95 or 98, run ScanDisk. Click
Start > Programs -> Accessories > System
Tools > ScanDisk.

In Windows NT, right click Start, click Explore,
and select a drive. Select File > Properties >
Tools. Under Error-checking, click Check Now.

Diskette drive cannot
read a diskette

Diskette is not formatted.

Format the diskette.

You are using the wrong
diskette type for the drive

type.

Check the type of drive you are using and use
the correct diskette type.

Drive not found

Cable is loose.

Reseat diskette drive cable.

Computer configuration does
not recognize second
diskette drive.

Use Computer Setup (F10 Setup) to enable the
second diskette drive. Select Diskettes from the
Storage menu.

Second Ultra ATA
hard drive does not
perform optimally

You are using the wrong
cable for the drive type.

Reinstall the second Ultra ATA hard drive using
an 80-conductor cable. The 80-conductor cable is
standard on select models.

Nonsystem disk
message

The system is trying to start
from a nonsystem diskette.

Remove the diskette from the drive.
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Solving Graphics

If you encounter graphics problems, refer to the documentation

Problems that came with your monitor and to the common causes and
solutions listed in the following table:
Problem Cause Solution

Blank screen

Monitor is not turned on and
the monitor light is not on.

Turn on the monitor and check that the monitor light
is on.

The cable connections are
not correct.

Check the cable connection from the monitor to the
computer and to the electrical outlet.

The energy saver feature
has been enabled.

Press any key or click the mouse button and, if set,
type your password.

The RGB (Red, Green,
Blue) input switch on the
monitor is incorrectly set.

Set the monitor's RGB input switch to 75 ohms and,
if there is a sync switch, set it to External.

System ROM is bad; system
is running in Failsafe Boot
Block mode (indicated by
one long beep and three
short beeps).

Reflash the ROM using a ROMPaq diskette. Refer
to the “Failsafe Boot Block ROM” section of the
Desktop Management guide for more information.

You are using a fixed-sync
monitor and it won't sync at
the resolution chosen.

Be sure that the monitor can accept the same
sweep rate as the resolution chosen.

The VGA/BNC selector
switch is not properly set.

Set the selector switch to agree with the cable
connection.

Monitor does not
function properly when
used with energy
saver features

Monitor without energy
saver capabilities is being
used with energy saver
features enabled.

Disable monitor energy saver feature.

Continued
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Solving Graphics Problems continued

Problem

Cause

Solution

Graphics colors are
wrong

The cabling or monitor
impedance is incorrect.

1. Ifyou are using BNC cables, be sure that the
Red, Green, and Blue BNC cables are
connected to the corresponding monitor
connectors.

2. Be sure your monitor's RGB inputs are set to
75 ohms.

Dim characters

The brightness and contrast
controls are not set properly.

Adjust the monitor brightness and contrast
controls.

Cables are not properly
connected.

Check that the graphics cable is securely
connected to the graphics card and the monitor.

The RGB switch on the back
of the monitor is incorrectly
set.

Set the RGB switch (and sync options, if this
option is available) to 75 ohms, with the sync set
to external. Refer to the documentation included
with the monitor.

Blurry video or
requested resolution
cannot be set

If the graphics controller was
upgraded, the correct
graphics drivers may not be
loaded.

Install the video drivers on the diskette included
in the upgrade Kkit.

Screen goes blank

You may have a screen
blanking utility installed or
energy saver features are
enabled.

Press any key or type password.

The picture is broken
up, or it rolls, jitters, or
blinks

The monitor connections
may be incomplete or the
monitor may be incorrectly
adjusted.

1. Be sure the monitor cable is securely
connected to the computer.

2. In a 2-monitor system or if another monitor is
in close proximity, be sure the monitors are
not interfering with each other’s
electromagnetic field by moving them apart.

3. Fluorescent lights or fans may be too close
to the monitor.

Monitor overheats

There is not enough
ventilation space for proper
airflow.

Leave at least 3 inches (7.6 cm) of ventilation
space. Be sure there is nothing sitting on top of
the monitor obstructing the air flow.
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Solving Audio

If your computer has audio features and you encounter audio

Problems problems, refer to the common causes and solutions listed in the

following table:

Problem Cause Solution

Sound does not come out Software volume control is Double click on the speaker icon on

of the speaker or turned down. the taskbar, then set volume by

headphones adjusting the volume slider.
CD-ROM or DVD volume Turn the volume control knob on front
control on the front of the of computer to increase the volume.

computer is turned down.

Solving Printer

If you encounter printer problems, refer to the documentation

Problems that came with your printer and to the common causes and
solutions listed in the following table:
Problem Cause Solution

Printer will not
print

Printer is not turned on and online.

Turn the printer on and make sure it is online.

The correct printer drivers for your
application are not installed.

Install the correct printer drivers for your application.

If you are on a network, you may
not have made the connection to
the printer.

Make the proper network connections to the printer.

Printer will not
turn on

The cables may not be connected
properly.

Reconnect all cables and check the power cord and
electrical outlet.

Prints garbled

The correct printer driver for your

Install the correct printer driver for your application.

information application is not installed.

The cables may not be connected Reconnect all cables.

properly.
Printer is The printer may be out of paper. Check the paper tray and refill it if it is empty. Select
offline online.

Troubleshooting
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Solving
Hardware
Installation
Problems

Y ou may need to reconfigure the computer when you add or remove
hardware, such as an additional diskette drive. If you install a Plug and
Play device, Windows 95 and Windows 98 automatically recognize the
device and configure the computer. If you install a non—-Plug and Play
device, you must reconfigure the computer after completing installation
of the new hardware. In Windows 95 and Windows 98, select the Add
New Hardwareicon in the Control Panel and follow the instructions
that appear on the screen. To reconfigure the computer in Windows NT
4.0 after installing new hardware, use the utility provided with the

hardware.

Problem

Cause

Solution

A new device is not
recognized as part of
the computer system

The computer needs to be
reconfigured to recognize the
device.

Follow the reconfiguration instructions above.

Cable(s) of new external
device are loose or power
cables are unplugged.

Ensure that all cables are properly and securely
connected and that pins in the cable or connector
are not bent down.

Power switch of new external
device is not turned on.

Turn off the computer, turn on the external
device, then turn on the computer to integrate the
device with the computer system.
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Solving Network

Some common causes and solutions for network problems are

Problems listed in the following table. These guidelines do not discuss the
process of debugging the network cabling.
Problem Cause Solution

Remote Wakeup feature
is not functioning

The Remote Wakeup feature
is not available when using an
AUI network connection.

Use an RJ-45 network connection.

Remote Wakeup is not
enabled.

Use the Network control application
to enable Remote Wakeup. Refer to
the Desktop Management guide.

Network driver does not
detect network controller

Network controller is disabled.

Run Computer Setup and enable
network controller.

Network status link light
does not turn on or
flashes

No active network is detected.

Check cabling and network
equipment for proper connection.

Network controller is not set up
properly.

Use the Network control application
to verify that device is working
properly. Refer to the Using Network
Communications guide.

System is configured for AUI
connection.

No solution; link LED does not apply
to AUI connections.

Network driver is not properly
loaded.

Reinstall network drivers. Refer to the
Using Network Communications
guide.

System cannot autosense the
network.

Disable autosensing capabilities and
force the system into the correct
operating mode. Refer to the Using
Network Communications guide.

Continued
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Solving Network Problems continued

Problem

Cause

Solution

Diagnostics reports a
failure

The cable is not securely
connected.

Ensure that the cable is securely
attached to the network connector
and that the other end of the cable is
securely attached to the correct
device.

The cable is attached to the
incorrect connector.

Ensure that the cable is attached to
the correct connector.

There is a problem with the
cable or a device at the other
end of the cable.

Ensure that the cable and device at
the other end are operating correctly.

The network controller is
defective.

Contact your Compagq authorized
service provider.

Network controller interrupt is
shared with an expansion
card.

Under the Computer Setup Advanced
menu, change the resource settings
for the card.

Diagnostics passes, but
the computer does not
communicate with the
network

Network drivers are not
loaded, or driver parameters
do not match current
configuration.

Make sure the network drivers are
loaded and that the driver parameters
match the configuration of the
network controller.

The network controller is not
configured for this computer.

Select the Network icon at the Control
Panel and configure the network
controller.

Continued
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Solving Network Problems continued

Problem

Cause

Solution

Network controller
stopped working when an
expansion board was
added to the computer

Network controller interrupt is
shared with an expansion
board.

Under the Computer Setup Advanced
menu, change the resource settings
for the board.

The network controller requires
drivers.

Verify that the drivers were not
accidentally deleted when the drivers
for a new expansion board were
installed.

The files containing the
network drivers are corrupted.

Reinstall the network drivers, using
the Compaq Restore CD.

Network controller
stopped working without
apparent cause

The files containing the
network drivers are corrupted.

Reinstall the network drivers, using
the Compaq Restore CD.

The cable is not securely
connected.

Ensure that the cable is securely
attached to the network connector
and that the other end of the cable is
securely attached to the correct
device.

The network controller is
defective.

Contact your Compagq authorized
service provider.

New network card will not
boot

New network card may not be
Compaq compatible.

Install Compag-compatible NIC or
change boot sequence to boot from
another device.

Cannot connect to
network server when
attempting Remote
System Installation

The network controller is not
configured properly.

Run Computer Setup (F10 Setup)
and modify the NIC Settings.

Troubleshooting
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Solving Memory
Problems

If you encounter memory problems, some common causes and
solutions are listed in the following table:

Problem

Cause

Solution

System won't boot or
does not function
properly after installing
additional memory
modules

Memory module is not the

correct type or speed grade for
the system or the new memory
module is not seated properly.

Replace module with the correct industry-
standard device for your computer.

Out of Memory error

Memory configuration may not
be set up correctly.

Use the Device Manager to check memory
configuration.

You have run out of memory to
run the application.

Check the application documentation to
determine the memory requirements.

Memory count during
POST is wrong

The memory modules may not
be installed correctly.

Check that the memory modules have been
installed correctly and that proper modules are
used.

Insufficient memory
error during operation

Too many Terminate and Stay
Resident programs (TSRs) are
installed.

Delete any TSRs that you do not need.

You have run out of memory
for your application.

Check the memory requirements for the
application or add more memory to the
computer.

Solving SCSI If you encounter SCSI device problems, refer to the common
Problems causes and solutions listed in the following table:
Problem Cause Solution
System with IDE and The IDE drive is not disabled Under the Computer Setup Advanced
SCSiI drives will not boot through the Computer Setup menu, disable the primary IDE
from SCSI hard drive utility. controller.

System without an IDE

The SCSI drive is not

drive will not boot from a configured correctly.

SCSI drive

Ensure that drive cabling and jumpers
are set correctly. To boot a SCSI drive,
the drive ID number must be set to 0.
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Solving CD-ROM and If you encounter CD-ROM or DVD problems, refer to the
DVD Problems common causes and solutions listed in the following table or
to the documentation that came with the optional device.

Problem Cause Solution
System will not boot The CD-ROM or DVD bootis  Run the Computer Setup utility (F10 Setup) and set
from CD-ROM or DVD  not enabled through the the drive priorities.
drive Computer Setup utility.
Non-bootable CD in drive. Try a bootable CD in the drive.
CD-ROM or DVD Drive is not connected Refer to the documentation that came with the
devices are not properly or not properly optional device.
detected or driver is configured.
not loaded

Movie will not play in Movie may be regionalized for Refer to the documentation that came with the DVD

the DVD drive a different country. drive.

Solving Software Most software problems occur as a result of the following:

Problems = The application was not installed or configured
correctly.

m  Thereisinsufficient memory available to run the
application.

m  Thereisaconflict between applications.

Where available, run the Compag Configuration Utility to
determine if any changes have been made to the software which
may be causing a problem. Refer to the online Intelligent
Manageability guide for more information.
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Troubleshooting
Using Compaq
Intelligent
Manageability
Features

Compaq
Configuration
Record Utility

The Local Alert Pop-Up Diaog notifies you of an impending or
actual hardware failure. If the computer is connected to a
network and the Compag Insight Management Agents are
installed and configured, a Simple Network Management
Protocol (SNMP) trap (message) is sent to the specified SNM P-
compliant management application.

The Local Alert Pop-Up Diaog also tells you the steps you need
to take prior to a hardware failure to avoid loss of data and
damage to the computer. The system administrator can create a
customized action message that might include contact telephone
or pager numbers.

To close the Local Alert Pop-Up Dialog, click the Close button.
To retrieve fault information after closing the dialog, run
Computer Diagnostics.

For more detailed information, refer to the online Intelligent
Manageability guide and the Desktop Management guide.

Compaqg Configuration Record Utility is an online information-
gathering tool similar to other Compag management tools. It
gathers critical hardware and software information from various
sources to give a complete view of the computer. Configuration
Record Utility provides a means for automatically identifying
and comparing configuration changes, and has the ability to
maintain a computer configuration history. The information can
be saved as a history of multiple sessions.

This utility was developed to allow resolution of problems
without taking the computer off-line and to assist in maximizing
computer availability. The information obtained by the utility is
useful in troubleshooting computer problems, and streamlines
the service process by enabling quick and easy identification of
computer configurations, which isthe first step in resolving
Service cases.

The Compag Configuration Record Utility is accessed viaan
icon in the Control Panel. When running the utility, information
isautomatically gathered on such items as the operating system
version number, operating system parameters, and the operating
system startup files. The utility then combines this information
with information on the hardware configuration to deliver a
comprehensive view of the computer.
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Contacting Compaq  For help and service, contact your Compag authorized reseller
Customer Support or dealer. For alist of phone numbers, consult the warranty.

L] s you take your computer to a Compag authorized reseller,
dealer, or service provider for service, remember to provide
the setup and power-on passwords, if they are set.

Troubleshooting  1-17



chapter 2
POST ERROR MESSAGES

Failure

Remove expansion boards.

Error Codes This chapter lists the error codes that you may encounter during
the Power-On Self-Test (POST) or computer restart, the
probable source of the problem, and what steps you can take to
resolve the error condition.

Power-0n Self-Test Messages

Message Beeps* Probable Cause Recommended Action

101-Option ROM 1L, 1S System ROM checksum. 1. Verify the correct ROM

Error 2. Flash the ROM if needed.

3. If an expansion card was recently
added, remove it and see if the
problem remains.

4. If the message disappears, there
may be a problem with the
expansion card.

5. Replace the system board.

102-System Board None DMA, timers, etc. 1. Clear CMOS.

Failure 2. Remove expansion boards.

3. Replace the system board.

103-System Board None DMA, timers, etc. 1. Clear CMOS.

2.

3.

Replace the system board.

*|L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message

Beeps*

Probable Cause

Recommended Action

162-System Options  2S
Not Set

Configuration incorrect.

RTC (real-time clock) battery
may need to be replaced.
Battery life is approximately
5 years.

Run Computer Setup (F10 Setup).

Reset the date and time under Control
Panel. If the problem persists, replace
the RTC battery. Refer to the Making
Hardware Changes guide for
instructions on installing a new battery,
or contact your Compag authorized
dealer or reseller for RTC battery
replacement.

163-Time & Date 2S
Not Set

Invalid time or date in
configuration memory.

RTC (real-time clock) battery
may need to be replaced.
Battery life is approximately
5 years.

CMOS jumper may not be
properly installed

Reset the date and time under Control
Panel. If the problem persists, replace
the RTC battery. Refer to the Making
Hardware Changes guide for
instructions on installing a new battery,
or contact your Compaq authorized
dealer or reseller for RTC battery
replacement.

Check for proper placement of the
CMOS jumper (if applicable).

164-Memory Size 2S
Error

Memory configuration
incorrect.

1. Run Computer Setup (F10 Setup)
or Windows utilities.

2. Make sure your memory
module(s) are installed properly.

3. Verify proper memory module
type.

183-Invalid 2S
Processor Jumper
Setting

System board jumper
improperly set.

Reset system board jumpers to match
processor and bus speeds (select
models).

* L =Long, S = Short

Continued
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Power-0n Self-Test Messages contined

Message Beeps*

Probable Cause

Recommended Action

201-Memory Error None

RAM failure.

1.

Run Computer Setup (F10 Setup)
or Windows utilities.

Ensure memory and continuity
modules are installed correctly.

Verify proper memory module
type.
Remove and replace the memory

module(s) one at a time to isolate
faulty module.

Replace faulty memory module(s).

If error persists after replacing
memory modules, replace the
system board.

202-Memory Type None
Mismatch

Memory modules do not
match each other.

Replace memory modules with
matched sets.

207-ECC Corrected  2S Single Bit ECC error. 1. Verify proper memory module
Single Bit Errors in type.
DIMM/SIMM Pair(s) 2. Try another memory socket.
X,X in Memory )
Module Socket(s) 3. Replace memory module if
problem persists.
yyy! e
213-Incompatible 2S A DIMM module in DIMM 1. Verify proper memory module
DIMM Module in socket identified in the error type.
DIMM Socket(s) X, messgge is missing .critical 2. Try another memory socket.
X, ... SPD information, or is ]
incompatible with the chipset. 3. Replace. DIMM with a module
conforming to the SPD standard.
301-Keyboard Error  None Keyboard failure. 1. Reconnect keyboard with
computer turned off.
2. Check connector for bent or
missing pins.
3. Ensure that none of the keys are
depressed.
4. Replace keyboard.

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
304-Keyboard or None Keyboard failure. 1. Reconnect the keyboard with
System Unit Error computer turned off.
2. Ensure that none of the keys are
depressed.
3. Replace the keyboard.
4. Replace the system board.
401-Parallel Port 1 2S IRQ address conflicts with Reset the IRQ.
Address Assignment another device.
Conflict
403-Parallel Port 3 2S IRQ address conflicts with Reset the IRQ.
Address Conflict another device.
Detected
404-Parallel Port 2S Both external and internal 1. Remove any parallel port
Address Conflict ports are assigned to parallel expansion cards.
Detected port X. 2. Clear CMOS.
3. Reconfigure card resources and/or
run Computer Setup (F10 Setup).
410-Audio Interrupt 2S IRQ address conflicts with Reset the IRQ.
Conflict another device.
411-Network 2S IRQ address conflicts with Reset the IRQ.
Interface Card another device.
Interrupt Conflict
501-Display Adapter 1L, 2S Graphics display controller. 1. Reseat the graphics card (if
Failure applicable).
2. Clear CMOS.
3. Verify monitor is attached and
turned on.
4. Replace the graphics controller.

*|L = Long, S = Short

Continued
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Power-0n Self-Test Messages contined

Message Beeps* Probable Cause Recommended Action
601-Diskette None Diskette controller circuitry or 1. Run Computer Setup (F10 Setup).
Controller Error floppy drive circuitry incorrect. 2. Check and/or replace cables.

3. Clear CMOS.

4. Replace diskette drive.

5. Replace the system board.
602-Diskette Boot None Diskette in Drive A not Replace the diskette.
Record Error bootable.
605-Diskette Drive 2s Mismatch in drive type. 1. Run Computer Setup (F10 Setup)
Type Error or Windows NT, Windows 95, or

Windows 98 utilities.
2. Disconnect any other diskette
controller devices (tape drives).

3. Clear CMOS.
610-External None External tape drive not Reinstall tape drive or press F1 and
Storage Device connected. allow system to reconfigure without the
Failure drive.
611-Primary Floppy 2S Configuration error. 1. Run Computer Setup (F10 Setup).
Port Address 2. Remove expansion cards.
Assignment Conflict

3. Clear CMOS.
612-Secondary 2S Configuration error. 1. Run Computer Setup (F10 Setup).
F'OPPV Port Addre;s 2. Remove expansion cards.
Assignment Conflict

3. Clear CMOS.
660-Display cache is None Integrated graphics controller  Replace system board if minimal
detected unreliable display cache not working graphics degrading is an issue.

properly and will be disabled.

912- Computer None No action required.

Cover Has Been
Removed Since Last
System Startup

*|L = Long, S = Short

Continued
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Power-0n Self-Test Messages contined

Message Beeps* Probable Cause Recommended Action
914-Hood Lock Coil  None Smart Cover Lock mechanism 1. Reconnect or replace Smart Cover
is not Connected is missing or not connected. Lock.
2. Reseat or replace Smart Cover
Lock cable.
916-Thermal Sensor None Processor heatsink cable not  Reseat or replace the processor
from Processor connected to system board. heatsink cable going to the system
Heatsink is not board.
Connected
917-Expansion Riser None Riser board not seated or not  Install riser board if missing or remove

not Detected

installed.

and reseat to ensure good connection.

1151-Serial Port 1 2S Both external and internal 1. Remove any serial port expansion
Address Conflict serial ports are assigned to cards.
Detected COM1. 2 Clear CMOS.
3. Reconfigure card resources and/or
run Computer Setup (F10 Setup).
1152- Serial Port 2 2S Both external and internal 1. Remove any serial port expansion
Address Conflict serial ports are assigned to cards.
Detected COM2. 2 Clear CMOS.
3. Reconfigure card resources and/or
run Computer Setup (F10 Setup).
1155-Serial Port 2S Both external and internal 1. Remove any serial port expansion
Address Conflict serial ports are assigned to cards.
Detected same IRQ. 2 Clear CMOS.
3. Reconfigure card resources and/or

run Computer Setup (F10 Setup).

1201-System Audio  2S
Address Conflict
Detected

Device IRQ address conflicts
with another device.

Reset the IRQ.

*L =Long, S = Short

Continued
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Power-0n Self-Test Messages contined

Message Beeps* Probable Cause Recommended Action
1202-MIDI Port 2S Device IRQ address conflicts  Reset the IRQ.

Address Conflict with another device.

Detected

1203-Game Port 2S Device IRQ address conflicts  Reset the IRQ.

Address Conflict with another device.

Detected

1720-SMART Hard None
Drive Detects
Imminent Failure

Hard drive is about to fail.
(Some hard drives have a
firmware patch that will fix an
erroneous error message).

Determine if hard drive is giving
correct error message. Run the
Drive Protection System test if
available.

Apply firmware patch if applicable.

Back up contents and replace hard
drive.

1721-SMART SCSI None
Hard Drive Detects
Imminent Failure

Hard drive is about to fail.
(Some hard drives have a
firmware patch that will fix an
erroneous error message).

Determine if hard drive is giving
correct error message.

Apply firmware patch if applicable.

Back up contents and replace hard
drive.

1771-Primary Disk 2s
Port Address
Assignment Conflict

Internal and external hard
drive controllers are both
assigned to the primary
address.

Remove any serial port expansion
cards.

Clear CMOS.

Reconfigure card resources and/or
run Computer Setup (F10 Setup).

* L =Long, S = Short

Continued
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Power-0n Self-Test Messages contined

Message Beeps* Probable Cause Recommended Action
1772-Secondary 2Ss Internal and external hard 1. Remove any serial port expansion
Disk Port Address drive controllers are both cards.
Assignment Conflict assigned to the secondary 2 Clear CMOS.
address.
3. Reconfigure card resources and/or

run Computer Setup (F10 Setup).

1780-Disk O Failure  None Hard drive/format error. Run Computer Setup (F10 Setup).
Clear CMOS.

Check cables/jumper settings.
Run hard drive diagnostics.

Disconnect additional drives.

o o w N PE

Run the Drive Protection System
test if available.

Replace the hard drive.

1781-Disk 1 Failure  None Hard drive/format error. Run Computer Setup (F10 Setup).
Clear CMOS.

Check cables/jumper settings.
Run hard drive diagnostics.

Disconnect additional drives.

o o~ w N P IN

Run the Drive Protection System
test if available.

7. Replace the hard drive.

*L =Long, S = Short Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
1782-Disk Controller None Hard drive circuitry error. 1. Run Computer Setup (F10 Setup).
Failure 2. Clear CMOS.
3. Check cable seating/jumper
settings.

Run hard drive diagnostics.

Disconnect additional drives.

o

Run the Drive Protection System
test if available.

Replace the hard drive.

Replace the system board.

1790-Disk 0 Error None Hard drive error or wrong
drive type.

Run Computer Setup (F10 Setup).
Clear CMOS.

w N Pl N

Check cable seating jumper
settings.

&

Run hard drive diagnostics.
Disconnect additional drives.

6. Confirm drive is supported on this
computer (large drive ROM
support).

7. Run the Drive Protection System
test if available.

8. Replace the hard drive.
9. Replace the system board.

*L =Long, S = Short Continued
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Power-0n Self-Test Messages contined

Message Beeps* Probable Cause Recommended Action
1791-Disk 1 Error None Hard drive error or wrong 1. Run Computer Setup (F10 Setup).
drive type. 2. Clear CMOS.
3. Check cable seating/jumper
settings.

4. Run hard drive diagnostics.
Disconnect additional drives.

Confirm drive is supported on this
computer (large drive ROM
support).

7. Run the Drive Protection System
test if available.

Replace the hard drive.

Replace the system board.

1792-Secondary None Hard drive circuitry error.
Disk Controller
Failure

Run Computer Setup (F10 Setup).
Clear CMOS.

w N PO

Check cable seating/jumper
settings.

»

Run hard drive diagnostics.

Disconnect additional drives.

o

Run the Drive Protection System
test if available.

Replace the hard drive.

1793-Secondary None Hard drive circuitry error.
Controller or Disk
Failure

Run Computer Setup (F10 Setup).
Clear CMOS.

w N PN

Check cable seating/jumper
settings.

e

Run hard drive diagnostics.
Disconnect additional drives.

Run the Drive Protection System
test if available.

7. Replace the hard drive.

*L =Long, S = Short Continued
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Power-0n Self-Test Messages continued

Message Beeps* Probable Cause Recommended Action
1800-Temperature None Internal temperature exceeds 1. Check that computer air vents are
Alert specification. not blocked and cooling fan is
running.
2. Verify processor speed selection.
3. Replace the processor.
4. Replace the system board.
1801 None Processor not supported by Upgrade BIOS to proper version.
ROM Bios.
Audible 1L, 3S System ROM is bad; system Reflash the ROM using a ROMPaq
is running in Failsafe Boot diskette. Refer to the “Failsafe Boot
Block mode. Block ROM” section of the Intelligent
Manageability guide.
Audible 2S Power-on successful. None.
Flashing Caps Lock 1L, 2S Graphics controller not 1. Following directions in Appendix A
LED on Keyboard present or incorrectly to clear CMOS.
initialized. 2. If graphics card has been added,
remove and reseat.
Flashing Num Lock 1S, 2L System memory not present. 1. Check memory module (refer to
LED on Keyboard the relevant section of the Making
Hardware Changes guide).
2. Remove and reseat memory
module.
3. See the “Solving Memory
Problems” section of this guide.
Num Lock LED ON None Failed Boot Block. Reflash the ROM using a ROMPaq
(keyboard) diskette. Refer to the “Failsafe Boot
Block ROM” section of the Intelligent
Manageability guide.
Flashing Scroll Lock 2L, 1S System board hardware Replace system board.

LED on keyboard

failure (prior to graphics).

*|L = Long, S = Short

Continued
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Power-0n Self-Test Messages contined

Message Beeps* Probable Cause Recommended Action

Green Power LED None Computer in normal Suspend  None

Blinks 1x / Second. mode.

Green Power LED None Computer on. None

On

Invalid Electronic None Electronic serial number has Run Computer Setup. If Setup already

Serial Number become corrupted. has data in the field or will not allow the
serial number to be entered, download
from www.compag.com and run
SP5572.EXE (SNZERO.EXE).

Flashing Power and  None Unseated riser board. 1. Remove riser board.

Hard Drive Green 2. Wipe connector.

LEDs i ]

3. Reinstall (refer to the Making
Hardware Changes guide for
directions on removing the riser
board).

Red Power LED None Power supply overloaded. 1. Push in power button. LED should

Blinks Every 2 or be green.

more Seconds. 2. Remove all AC power from
computer, wait 30 seconds, then
apply power.

3. Remove load from power supply
by removing options one at a time
until computer runs.

4. Check for damage to system
board.

5. Replace system board.

6. Replace power supply.

Red Power LED None System memory error. 1. Check memory module (refer to
Blinks Every Second the relevant section of the Making
Hardware Changes guide).

2. Remove and reseat memory
module.

3. See the “Solving Memory

Problems” section of this guide.

*|L =Long, S = Short

Continued
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Power-0n Self-Test Messages contined

Message Beeps* Probable Cause Recommended Action

Red Power LED None Computer overheated. 1. Install computer cover or access
Blinks Four Times panel if necessary.

per Second

2. Ensure that computer air vents are
not blocked and internal fan is
running.

Red Power LED On None Processor unseated.

Reseat processor in system board.

*|L = Long, S = Short

[] If you have replaced the standard keyboard with a Universal Serial Bus (USB) keyboard, you
will hear the beep sequences for these error codes but will not see the flashing keyboard lights.
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appendix A

PASSWORD SECURITY AND
CLEARING AND RESETTING CMOS

This computer supports security password features, which can
be established through the Computer Setup Utilities menu.

This computer supports two security password features that are
established through the Computer Setup (F10 Setup) Utilities
menu: setup password and power-on password. When you
establish only a setup password, any user can access all the
information on the computer except Computer Setup (F10
Setup). When you establish only a power-on password, the
power-on password is required to access Computer Setup (F10
Setup) and any other information on the computer. When you
establish both passwords, only the setup password will give you
access to Computer Setup (F10 Setup).

When both passwords are set, the setup password can aso be
used in place of the power-on password as an override to log
into the computer. Thisis auseful feature for a network
administrator.

If you forget the password for your computer, there are two
methods for clearing that password so you may gain access to
the information on the computer:

m  Resetting the password jumper
m  Using the Clear CMOS button

CAUTION: Pushing the CMOS button will reset CMOS values to
factory defaults and will erase any customized information
including passwords, asset numbers, and special settings.
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Resetting the To disable the power-on or setup password features, or to
Password Jumper clear the power-on or setup passwords, complete the
following steps:

1. Turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external
devices connected to the computer.

WARNING: To reduce the risk of personal injury from electrical
shock and/or hot surfaces, be sure to disconnect the power cord
from the wall outlet, and allow the internal system components to
cool before touching.

A CAUTION: When the computer is plugged in, the power supply
always has voltage applied to the system board even when the unit
is turned off. Failure to disconnect the power cord can result in
damage to the system.

A CAUTION: Static electricity can damage the electronic
components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of
static electricity by briefly touching a grounded metal object. Refer
to the Safety & Regulatory Information guide for more information.

3. Remove the computer cover or access panel.
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4. Locate the header and jumper labeled E49.

Location and Identification of the Password Jumper on a Compaq Deskpro EP System
Board (Intel 810 Chipset)

Location and Identification of the Password Jumper on a Compaq Deskpro EN System
Board (Intel 810 Chipset)
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]
Location and Identification of the Password Jumper on a Compaq Deskpro EN SFF, Front-
Mounted Audio Solution System Board (Intel 810 Chipset)

5. Remove the jumper from pins 1 and 2. Place the jumper
over pin 2 only, in order to avoid losing it.

6. Replace the computer cover or access panel.
7. Reconnect the external equipment.

8. Plug in the computer and turn on power. Allow the
operating system to start. This clears the current passwords
and disables the password features.

9. To re-enable the password features, repeat steps 1-4, then
replace the jumper on pins 1 and 2.

Repeat steps 6-8, then establish new passwords. Refer to
the Making Hardware Changes guide for Computer Setup
(F10 Setup) instructions.
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Clearing and The computer’ s configuration memory (CMOS) stores

Resetting the CMOS password information as well information about the computer’s
configuration.

Using the CMOS Button

1. Turn off the computer and any external devices, and
disconnect the power cord from the power outlet.

2. Disconnect the keyboard, monitor, and any other external
equipment connected to the computer.

WARNING: To reduce the risk of personal injury from electrical
shock and/or hot surfaces, be sure to disconnect the power cord
from the wall outlet, and allow the internal system components to
cool before touching.

A CAUTION: When the computer is plugged in, the power supply
always has voltage applied to the system board even when the unit
is turned off. Failure to disconnect the power cord can result in
damage to the system.

A CAUTION: Static electricity can damage the electronic
components of the computer or optional equipment. Before
beginning these procedures, ensure that you are discharged of
static electricity by briefly touching a grounded metal object. Refer
to the Safety & Regulatory Information guide for more information.

3. Remove the computer cover or access panel.
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4. Locate, press, and hold the CMOS button in for 5 seconds.

CGAUTION: Pushing the CMOS button will reset CMOS values to
factory defaults and will erase any customized information
including passwords, asset numbers, and special settings.

CMOS Pushbutton

5. Replace the computer cover or access panel.

6. Reconnect the external devices.

7. Plug in the computer and turn on power.

[ Youwill need to reset your passwords and any specia system

setups. Refer to the “Using Computer Setup” section below for
further instructions.

Using Computer Setup to Reset CMOS

To reset CMOS, you must first access the Computer Setup (F10
Setup) Utilities menu.

When the Computer Setup (F10 Setup) message appears in the
lower-right corner of the screen, pressthe F10 key. Press Enter
to bypass the title screen, if necessary.
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L] 1 you do not press the F10 key while the messageis

displayed, you must turn the computer off, then on again,
to access the utility.

A choice of five headings appears in the Computer Setup (F10
Setup) Utilities menu: File, Storage, Security, Power, and
Advanced.

To reset CMOS to the factory default settings use the arrow
keys or the Tab key to select File— Set Defaults and Exit.

Refer to the Desktop Management guide for further instructions
on reestablishing passwords. For instructions on Computer
Setup (F10 Setup), see Making Hardware Changes.
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appendix B
COMPUTER DIAGNOSTICS

Compaq Diagnostics  Compag Diagnostics for Windows is a component of Intelligent
for Windows Manageability that allows you to view:

= System overview

m  AssetControl information
= Input devices

= Communications ports

m  Storage devices

m  Graphicsinformation

= Memory configuration

= Security management settings
= System hedlth

= Operating system

= Windows version

Depending on the version, Compaq Diagnostics for Windows
may include diagnostic tests to determine if all the devices
installed on the computer are recognized by the system and are
functioning properly.
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Using Compaq Diagnostics for Windows

1. Select the Compaq Diagnosticsicon, located in the Control
Panel.

The screen displays an overview of the computer hardware
and software.

2. For specific hardware and software information, select a
category from the Categories menu or from the toolbar.

[] As you move your cursor over the toolbar icons, the
corresponding category names appear near the cursor.

3.  Todisplay more detailed information in a selected
category, click More in the Information Level box.

4. Review and print thisinformation and, if necessary, discuss
it with your authorized Compaq reseller or service
provider.

D To print the information, click File, then select Print.
Select one of the following options: Detailed Report (All
Categories), Summary Report (All Categories), or Current
Category. Click OK to print the report you selected.

5. To exit Compag Diagnostics for Windows, click File, then
click Exit.
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Running Diagnostic Tests

If your version of Compag Diagnostics for Windows includes
diagnostic testing utilities, four tabs will appear next to
Overview: Tedt, Status, Log, and Error.

1. Select the Test tab.
2. Select one of the following options:

O Quick Test—Runsaquick, general test on each
device with aminimal number of prompts.

0 Complete Test—Runs maximum testing of each
device with minimal prompts.

0 Custom Test—Runs only the tests you select. To
select specific devices or tests, find the devicein the
list, then click the box beside each test to select or
deselect it. When selected, ared check mark appearsin
the box.

3. Select Interactive Mode or Unattended Mode.

In Interactive Mode, the diagnostic software will prompt
you for input during tests that require it. Some tests require
interaction and will display errors or halt testing if selected
in conjunction with Unattended Mode.

4. Click the Begin Testing button.
Test Status is displayed, showing the progress and result of
each test.

5. If errorsare found, click the Error tab to display more
detailed information and recommended actions. By
following the recommended actions, you may be able to
solve some problems yourself.

6. Click Print or Save the error information in case you need
to contact your Compaq authorized dealer, reseller, or
service provider for assistance.

7. To exit Compag Diagnostics for Windows, click File, then
click Exit.
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appendix C

DRIVE PROTECTION SYSTEM
(DPS)

Introducing the The Compaq Drive Protection System (DPS) is a diagnostic
Drive Protection tool built into the hard drivesinstalled in select Compaq
System Deskpro computers. DPS is designed to help diagnose problems

that might result in unwarranted hard drive replacement.

When Compag Deskpro Computers are built, each installed hard
drive istested using DPS and a permanent record of key
information is written onto the drive. Each time DPSis run, test
results are written to the hard drive. Y our service provider can
use thisinformation to help diagnose conditions that caused you
to run the DPS software.

Running DPS will not affect any programs or data stored on the
hard drive. The test resides in the hard drive firmware and can
be executed even if the computer will not boot to an operating
system. The time required to execute the test depends on the
manufacturer and size of the hard drive; in most cases, the test
will take approximately 2 minutes per gigabyte.

Use DPS when you suspect a hard drive problem. If the
computer reports a SMART Hard Drive Detect Imminent
Failure message, there is no need to run DPS; instead, back up
the information on the hard drive and contact your Compaqg
service provider for areplacement hard drive.
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Accessing DPS To access DPS through Compag Diagnostics for Windows,
Through Gompag perform the following steps:

Diagnostics for
Windows

. Turn on the computer and select My Computer — Control

Panel — Compag Diagnostics.
A choice of five possible headings appearsin the
Diagnostics screen: Overview, Test, Status, Log, and Error.

. Select Test - Type of Test

A choice of threetests appear: Quick Test, Complete Test,
and Custom Test.

Select Custom Test.

' A choice of two test modes is offered: Interactive Mode

and Unattended Mode.

4. Select Interactive Test — Storage —» Hard Drives.
. Select the specific drive(s) to be tested - Drive Protection

System Test - Begin Testing.

When the test has been compl eted, one of three messages will be
displayed for each of the drives tested:

Test Succeeded. Completion Code O.
Test Aborted. Completion Code 1 or 2.

Test Failed. Drive Replacement Recommended. Completion
Code 3 through 14.

If the test failed, the completion code should be recorded and
reported to your service provider for help in diagnosing the
computer problem.
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Accessing DPS When the computer does not power-on properly you should use
Through Computer Computer Setup (F10 Setup) to access the DPS program. To
Setup access DPS, perform the following steps:

1. Turnon or restart the computer.

2. When the F10 Setup message appears in the lower-right
corner of the screen, pressthe F10 key.

L] 1f you do not press the F10 key while the messageis
displayed, you must turn the computer off, then on again,
to access the utility.

A choice of five headings appears in the Computer Setup
Utilities menu: File, Storage, Security, Power, and Advanced.

3. Select Storage— IDE DPS Self-Test.
The computer screen will display the list of DPS-capable
hard drives that are installed on the computer.

[ 1f noDPS capable hard drives are installed, the IDE DPS
Self-Test option will not appear on the screen.

4. Select the hard drive to be tested and follow the screen
prompts to complete the testing process.

When the test has been completed, one of three messages will be
displayed:

m  Test Succeeded. Completion Code O.

m  Test Aborted. Completion Code 1 or 2.

m Test Faled. Drive Replacement Recommended. Completion
Code 3 through 14.

If the test failed, the completion code should be recorded and
reported to your service provider for help in diagnosing the
computer problem.
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